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LATEX zu benutzen ist das eine, dafür gibt es bereits hervorragende Einfüh-
rungen. Was aber wird für die Installation eines LATEX-Systems unter Windows
benötigt? Was mache ich mit MiKTEX, wozu brauche ich Ghostscript, was ist
TeXnicCenter, und warum schwören viele auf Emacs und vor allem wie paßt
alles zusammen? Diese Informationen muß man sich meist aus vielen verschie-
denen Quellen zusammensuchen, und manchmal scheint manches nicht zu-
sammenzupassen, während man vielleicht nur an der falschen Stelle gesucht
hat.

Diese Anleitung soll die Suche ersparen und zeigt Schritt für Schritt, was man
alles braucht und wie man die einzelnen Komponenten einrichtet und benutzt.

Wenn Ihnen diese Anleitung gefällt, hilft Ihnen bestimmt auch mein
Buch „Wissenschaftliche Arbeiten schreiben mit LATEX“, erschienen im mitp-
Verlag, ISBN 3-8266-1633-2.

Dieses Dokument darf und soll frei und kostenlos weiterverbreitet werden. Der Hinweis
auf den Autor muß erhalten bleiben. Über Anregungen und Hinweise auf eventuelle Feh-
ler freue ich mich natürlich. Für diese bitte die Versionsnummer mit angeben:
Revision: 1516 Date: 2008-05-26 22:04:28 +0200 (Mo, 26 Mai 2008)

Dank an Thomas Schmelzer, Jan-Philipp Schlaak, Robert Bitsche, Stefan Strohmeier, Ger-
hard Huber, Andreas Sydow und viele andere für viele Anmerkungen und Korrekturen.

Dieses Dokument existiert sowohl in HTML als auch in PDF 1.51. Die korrekten URL
lauten:

• http://schlosser.info/downloads/latexsystem.pdf für die PDF-Version und

• http://schlosser.info/latexsystem für die HTML-Seite.

Eine englische Fassung ist verfügbar:
http://schlosser.info/latexsystem-en

1Adobe Reader 6.0 oder neuer oder Ghostscript/GSview erforderlich.
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1 Intention

LATEX ist kein Programm, sondern eine Sprache bzw. eine Methode der Dokumentbeschrei-
bung und wird benutzt in Form eines LATEX-Systems. Damit lassen sich nicht nur wissen-
schaftliche Arbeiten verfassen, sondern auch hervorragende Briefe, Präsentationen und
vieles mehr.

Für diejenigen, die bisher nicht mit freier Software gearbeitet haben, ist es anfangs be-
fremdlich, selbst verschiedene Komponenten zu einem System zu integrieren, so daß sich
manche vielleicht nicht so einfach hintrauen. Deswegen stelle ich hier meine Umgebung
vor, mit der ich aus LATEX sowohl Postscript und PDF als auch HTML erzeuge.

Dies ist keine Einführung in LATEX, dafür gibt es bereits hervorragende Angebote so-
wohl im Netz als auch in Buchform. Zum Einstieg bis zum kompletten Ergebnis eignet
sich mein Buch2 oder als kurzer Reinschmecker auch die LATEX 2ε-Kurzbeschreibung, die
zum einen bei jeder LATEX-Distribution dabei ist in <texmf>/doc/guides/lshort-german/,
oder von CTAN.org3 heruntergeladen werden kann. Unbedingt empfehlenswert ist auch
die De-TeX-FAQ4, zu beziehen vom Dante-Server5, außerdem l2tabu, das veraltete Befehle
und Pakete und ihre Alternativen aufzeigt. Nicht zu vergessen ist die Dokumentation von

2Schlosser, Joachim: Wissenschaftliche Arbeiten schreiben mit LaTeX. mitp Verlag, Dezember 2006, ISBN 3–
8266–1633–2.

3CTAN ist die Abkürzung für Comprehensive TeX Archive Network, der vollständigsten Sammlung von TEX-
bezogener Software.

4Raichle, Bernd/Niepraschk, Rolf/Hafner, Thomas: Fragen und Antworten (FAQ) über das Textsatzsystem
TEX und DANTE, Deutschsprachige Anwendervereinigung TEX e.V. DANTE e.V. http://www.dante.de/
faq/de-tex-faq/.

5Dante: Deutschsprachige Anwendervereinigung TeX e. V.
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2 Softwarepakete

KOMA-Skript, einer in Europa verbreiteten Makrobibliothek und die darüber hinaus Ant-
worten auf viele typographische Fragen bereit hält. Er ist zu finden in jeder besseren LATEX-
Distribution unter <texmf>/doc/latex/koma-script/.

Wer mit der Installation trotz der Anleitung nicht zurecht kommt oder eine sonstige Fra-
ge zum Thema LATEX hat, der schreibe nicht gleich mir persönlich, sondern suche zunächst
im Web und in der FAQ und wende sich bei anhaltender Unklarheit an die Newsgruppe
de.comp.text.tex6. Dort können die meisten Fragen beantwortet werden; und auch zum The-
ma Installation unter Windows antworte ich dort viel lieber als per Mail, weil zum einen
die Antworten dann allen zur Verfügung stehen und außerdem dort viele kompetente An-
wender und Entwickler mitlesen.

Letzte wichtige Anmerkung: Diese Anleitung ersetzt nicht die Originaldokumentationen
der einzelnen Programme und Bausteine7. Bei Fehlern tut man gut daran, die Dokumen-
tation des jeweiligen Programms zur Hilfe zu nehmen. Die Anleitung bezieht sich aus-
schließlich auf die hier angegebenen Programme. So sind z. B. die Abschnitte über Emacs
und Aufsätze nicht ohne weiteres auf XEmacs übertragbar. Neuere Versionen der Program-
me stellen in der Regel kein Problem dar (ohne Gewähr). �

Besonders genau zu befolgende Absätze sind wie dieser gekennzeichnet.

2 Softwarepakete

Um vernünftig arbeiten zu können, benötigt man neben der eigentlichen TEX Distribution
verschiedene Komponenten. Eine Zusammenfassung aller bei mir installierten Programm-
pakete und deren Versionen findet sich im Abschnitt 2.5.

2.1 LATEX Distribution: MiKTEX

Die LATEX-Distribution ist der Kern des Systems. Sie beinhaltet die wichtigsten Programme,
die zum Erzeugen von DVI, Postscript und PDF notwendig sind, außerdem alle Zusatzpa-
kete, die erweiterte Möglichkeiten wie z. B. Musiksatz, Standardlayouts für verschiedene
Organisationen, Layoutbesonderheiten u. ä. bieten.

Ich verwende MiKTEX 2.7. Diese Distribution ist meines Erachtens nach sehr einfach zu
installieren, funktioniert prächtig und wird gut gepflegt. Je nach gewünschtem Umfang
sind 30 bis 500 MB herunterzuladen. Alternativ kann man eine – jedoch nicht immer ganz
aktuelle – CD bestellen.

2.2 Editor

Die Distribution ist nur dafür verantwortlich, aus der Eingabe die Ausgabe zu generieren.
Die Eingabe selbst nimmt man im Editor seiner Wahl vor. Die Wahl fällt bei mir auf GNU
EMACS. Daneben möchte ich auch TEXNICCENTER ansprechen.

6Suchen kann man anstatt mit einem Newsclient wie Thunderbird wunderbar auch mit dem Webinterface
auf http://groups.google.de/group/de.comp.text.tex

7Siehe dazu auch meinen Beitrag in de.comp.text.tex
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2 Softwarepakete

2.2.1 TeXnicCenter

Damit der LATEX-Einstieg nicht zu schwer fällt, empfehle ich abweichend von meiner Kon-
figuration als Editor den TEXNICCENTER.

TEXNICCENTER ist wohl für mausorientierte Benutzer der angenehmere der beiden hier
vorgestellten LATEX-Editoren. Vordefinierte Ausgabeprofile und vieles mehr machen ihn zu
einem durchaus brauchbaren Werkzeug. TEXNICCENTER ist gerade für den Neuling in
LATEX geeignet, der EMACS noch nicht kennt. Schließlich reicht es für den Anfang völlig
aus, ein Konzept lernen zu müssen. Später kann und sollte man dann auf das Profigerät
EMACS umsteigen.

Dennoch sei hier betont, daß TEXNICCENTER sehr vieles missen läßt, was bei EMACS

selbstverständlich ist, wie z. B. eine Numerierung in der Gliederungsansicht oder eine lei-
stungsfähige Behandlung von Marken (Labels) und Literaturzitaten. Auch die integrierte
Rechtschreibprüfung hat bei weitem nicht die Qualität, wie sie ISPELL/ASPELL für EMACS

bietet. Die Hilfefunktion ist zwar teilweise auf Deutsch, dafür jedoch relativ mager. gesät.

2.2.2 Emacs + RefTeX + AucTeX/Preview-LATEX + Ispell

Wer unter Unix bereits mit LATEX gearbeitet hat, benutzt eventuell den EMACS, der auch für
Windows portiert wurde. Hier ist REFTEX bereits dabei, ebenso AUCTEX.

Ich habe mich nicht allein wegen des Editors zum Umstieg auf den EMACS entschie-
den, sondern wegen der Zusätze AUCTEX und REFTEX. AUCTEX bietet für alle häufig
benutzten Konstrukte aus LATEX Tastaturkürzel an, die das Arbeiten erheblich beschleuni-
gen. REFTEX läßt den Benutzer beim Einfügen von Querverweisen aus einer Liste aller
verfügbaren auswählen und hilft beim Erstellen der entsprechenden Marken. Auch das
Einfügen von Literaturzitaten geht mit REFTEX wesentlich schneller und einfacher.

Es bietet sich auf jeden Fall an, die Einführungen zu EMACS und AUCTEX zu lesen und
sich von www.refcards.com die EMACS Referenzkarte zu holen. Der anfängliche Lernauf-
wand lohnt sich, wird er doch bald mehr als aufgewogen durch ein schnelles, effizientes
Arbeiten.

Auch auf eine Rechtschreibprüfung muß man nicht verzichten in EMACS. Sie heißt IS-
PELL und ist hervorragend in den Editor integriert. Eine für Windows portierte Version, die
ich zur einfacheren Verwendung mit einer Installationsroutine versehen habe, stelle ich auf
meiner Homepage8 zur Verfügung. Sie enthält Wörterbücher für Englisch und Deutsch.
Weitere Wörterbücher, z. B. für die „neue“ deutsche Rechtschreibung9, Französisch, Italie-
nisch, u. v. m., finden sich im Netz.

Als letzten Zusatz verwende ich das WYSIWYG10-Plugin PREVIEW-LATEX, welches die
Formeln, Graphiken und Tabellen als Vorschau in etwa so anzeigt, wie sie später im Do-
kument erscheinen werden. Somit wird das Beste aus den beiden Welten WYSIWYG und
Offlinebearbeitung vereint11. Formeln beispielsweise werden in der mächtigen LATEX-Syn-
tax eingegeben und gleich nach der Eingabe als Vorschau angezeigt, so daß man sich in

8http://schlosser.info/latex
9die ich übrigens ablehne; siehe dazu auch meinen entsprechenden Artikel http://schlosser.info/kultur

10Abkürzung für „What-you-see-is-what-you-get“: Man sieht bereits beim Bearbeiten das Dokument oder
Teile davon in einer Form, die in etwa dem späteren Ergebnis entspricht.

11Kastrup, David: Revisiting WYSIWYG paradigms for authoring LaTeX. TUGboat, 23 November 2002, Nr. 1.
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2 Softwarepakete

seinem Dokument leichter orientieren und besser querlesen kann, ohne in einem zweiten
Fenster immer eine übersetzte Version des Dokuments öffnen zu müssen. Für die Installati-
on von PREVIEW-LATEX wird neben GHOSTSCRIPT eine Shell-Umgebung benötigt. Hierfür
ist MSYS aus dem Minimalist GNU for Windows-Projekt (MinGW) bestens geeignet.

EMACS bietet unter anderem eine Buttonleiste und ist vollständig über Menüs konfigu-
rierbar, dazu kommt eine ausgezeichnete Hilfefunktion (in Englisch).

2.3 Graphiken in Postscript mit Ghostscript

Für Unix-Kenner ist es selbstverständlich, für Windowsbenutzer anfangs ungewohnt: Die
Benutzung von Postscript als Austauschformat für Vektorgraphiken aller Art. So ist es
auch unter LATEX am besten, Graphiken als (Encapsulated) Postscript (PS/EPS) einzubin-
den.

Aus allen Windowsanwendungen mit ihren Dateiformaten wie z. B. existierende Word-
oder PowerPoint-Zeichnungen, Bitmaps oder Vektorformaten wie CorelDraw läßt sich
problemlos Postscript erzeugen, auch wenn die jeweilige Anwendung dies nicht direkt
unterstützt. Möglich wird dies durch Drucken in eine Datei über einen Postscript Drucker-
treiber, und zwar mit dem Treiber für den Apple Color LaserWriter 12/600.

Um später vorliegende Postscriptdateien anzusehen und kleinere Veränderungen vorzu-
nehmen, benötigt man GHOSTSCRIPT – egal ob AFPL oder GNU – mit seinem graphischen
Frontend GSVIEW.

Mit diesen ersten drei Komponenten läßt sich die primäre Aufgabe von LATEX bereits
perfekt erledigen: Das Erstellen von druckfertigen, perfekt gesetzten Dokumenten.

2.4 HTML-Konvertierung

Bislang habe ich an dieser Stelle LATEX2HTML empfohlen. Aus verschiedenen Gründen12

bin ich davon abgekommen. Ich habe mich nun für TEX4HT entschieden. Dies nutzt einen
komplett anderen Ansatz bei der Übersetzung, der mir flexibler und universeller erscheint.

TEX4HT hat zudem den Vorteil, daß es als Paket in der Distribution MIKTEX enthalten
ist13. Wer allerdings die absolut neueste Version haben möchte, muß und kann sich diese
problemlos nachinstallieren. Dies mag sich empfehlen, da der Autor von TEX4HT sehr
aktiv ist und das Programms fortlaufend verbessert.

TEX4HT, egal ob mitgelieferte oder selbstinstallierte Version, benötigt zur Graphikkon-
vertierung das Programm IMAGEMAGICK, welches sehr schnell und einfach installiert ist.

2.5 Übersicht

Die angegebenen Paketgrößen beziehen sich auf das Downloadvolumen, nicht auf den für
die Installation benötigten Platz.

12unterstützte Pakete, Erweiterbarkeit, Validität der Ausgabe
13Zur Benutzung siehe die Dokumentation in <texmf>/doc/html/tex4ht.
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3 Installation und Konfiguration

Programm Größe MB Quelle

MiKTEX 50–400 MB http://www.miktex.org
TeXnicCenter 5 MB http://www.toolscenter.org
Emacs+AucTex-W32 39 MB http://www.gnu.org/software/auctex/
gnuserv 0,2 MB http://wyrdrune.com/gnuserv.html
Ispell Win32 1,5 MB http://schlosser.info/latex
Ghostscript 10 MB http://ghostscript.com/releases/
GSview 1,5 MB http://pages.cs.wisc.edu/~ghost/gsview/
TeX4ht 1,5 MB http://www.cse.ohio-state.edu/~gurari/TeX4ht/mn.html
ImageMagick 9,5 MB http://www.imagemagick.org

Σ ca. 455 MB

2.6 Lizenzierungen

Alle in dieser Anleitung genannten Programme und Pakete sind mindestens kostenlos,
meist sogar freie Software14. Die Lizenzen sagen allesamt aus, daß die Verbreitung frei-
gestellt ist. Die meisten erlauben zudem die Veränderung des Quellcodes, einige wenige
verbieten wiederum den kommerziellen Verkauf.

Es gibt auch kommerzielle LATEX-Distributionen und Editoren, die ihre Vorteile haben
mögen, wenngleich ich dies im Falle des Editors gegenüber EMACS stark in Zweifel ziehe.
Für Erfahrungsberichte oder Beschreibungen von Distributionen oder Editoren wie Wi-
nEdt verweise ich auf die Informationsfülle des Internets.

Trotz der prinzipiellen Kostenfreiheit hat man natürlich die Möglichkeit, sich bei den
einzelnen Projekten bei Gefallen auch finanziell erkenntlich zu zeigen. Siehe dazu die Web-
seiten der Projekte.

3 Installation und Konfiguration

Mein System läuft auf Windows XP Professional. Einige Zugriffspfade zu bestimmten Sy-
stemeinstellungen können auf Ihrem System geringfügig von den beschriebenen abwei-
chen.

Zugriffspfade bezeichnen Startmenüeinträge, Schaltflächen und Menüeinträge mit den
entsprechenden Namen. �

Für alle zu wählenden Verzeichnisse gilt: Die Verzeichnisnamen sollten keine Leerzei-
chen enthalten, da dies vielerlei Probleme verursachen kann. Also besser C:\Programme
statt C:\Program Files und besser C:\MyUser statt C:\Dokumente und Einstellungen\C
My User. �

Die Reihenfolge der einzelnen Schritte ist wegen Programmabhängigkeiten unbedingt
einzuhalten. Diese Anleitung ist selbstkonsistent, d. h. alle Verzeichnisse passen zusam-
men. Verwendet jemand ein anderes Verzeichnis für ein Programm, muß dies in nachfol-
genden Schritten selbst berücksichtigt werden.

14Was bekanntlich ein Unterschied zu kostenlos ist: „Free as free speech, not free beer.“ Siehe dazu die Seiten
der Free Software Foundation unter http://www.fsf.org.
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3 Installation und Konfiguration

3.1 MiKTEX herunterladen und installieren

Man lade sich von http://www.miktex.org als erstes den Webinstaller und rufe diesen auf.
Nun muß man sich Gedanken machen, was man will, denn es gibt drei Varianten small
und total. Wer breitbandig ans Internet angeschlossen ist, holt sich am besten total, an-
sonsten eben die kleinere. Wenn man sich etwas eingearbeitet hat, kann man dann auch
direkt einzelne Pakete vom FTP-Server herunterladen, so daß auch eine beschränkte Inter-
netanbindung kein Hindernis darstellt. Alternativ kann man auch eine mehrmals im Jahr
aktualisierte CD-ROM des Systems bestellen.

Die Installation selbst ist sehr simpel: Einfach so lange auf weiter klicken, bis man fertig
ist und allen Vorgaben folgen. Alle Programme können dann direkt von der Kommando-
zeile aufgerufen werden.

Vor dem ersten Arbeiten sollte man einmal den DVI-Viewer aus der MIKTEX-Pro-
grammgruppe des Startmenüs ausführen, damit dieser sich ordnungsgemäß im System
registrieren kann.

Wer es lieber noch mit ein paar Bilder hat, kann bei MIKTEX auch nach Schenk, Christi-
an: The MiKTeX Installation Procedure. 2004 http://www.dante.de/help/documentation/
miktex/ vorgehen (nur auf Englisch).

3.2 Graphikerstellung und -konvertiertung

Man beginnt am besten mit dem Postscript Druckertreiber. Dieser wird eingerichtet mit
Start → Einstellungen → Drucker → Neuer Drucker. Als erstes lokaler Drucker wählen und
als Anschluß den FILE-Port, der richtige Treiber ist der Apple Color LaserWriter 12/600. Den
Druckernamen auf „Postscript File“ setzen.

Nach der Installation unter Start→ Einstellungen→ Drucker→ Postscript File→ Drucker
→Druckeinstellungen→ Erweitert→Optionen für Dokument→ Postscript-Optionen folgende
Einstellungen vornehmen: Die Felder Postscript-Ausgabeoption auf „Optimale Portabilität“
und TrueType-Downloadoption auf „Umriß“ setzen. Das ICM Color Matching muß deaktiviert
werden, um Farbverfälschungen zu vermeiden, und der Print Quality Mode auf „Best“ ste-
hen.

Ab sofort kann jede Windowsanwendung Postscriptdateien erzeugen, indem man ein-
fach den neuen Drucker verwendet. Die erzeugte Datei – der man immer die Erweiterung
.ps anstatt des vorgegebenen .prn geben sollte – kann man nun in GSVIEW betrachten und
nach EPS wandeln.

Für die automatische Weiterverarbeitung installiert man GHOSTSCRIPT, zu ziehen von
http://ghostscript.com/releases/. Hier gibt es nichts zu beachten (also Enter bis fertig).
Da vielleicht auch der Wunsch besteht, Postscriptdateien zur Kontrolle anzusehen, spielt
man GSVIEW15, das graphische Frontend zu GHOSTSCRIPT ein. Hier kann man bei der
Installation das Verzeichnis ebenfalls auf C:\gs setzen, auch als Programmgruppe kann
man die gleiche wie bei GHOSTSCRIPT wählen.

Es ist überaus sinnvoll, GHOSTSCRIPT dem Suchpfad hinzuzufügen. Also wiedereinmal
in Start → Einstellungen → Systemsteuerung → System → Erweitert → Umgebungsvariablen
der Variable PATH das jeweilige Verzeichnis, z. B. c:\gs\gs8.53\bin, durch Semikolon ab-
getrennt hinzufügen. Wichtig: Keine Leerzeichen vor und nach Einträgen in der PATH- �

15GSview. http://pages.cs.wisc.edu/~ghost/gsview/.
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3 Installation und Konfiguration

Variable!
Um sich auf die Dauer die Arbeit zu erleichtern, empfehle ich, einen „EPS-Drucker“

einzurichten und zu verwenden, auch dafür habe ich eine kurze Anleitung verfaßt16.

3.3 TeXnicCenter einrichten

TEXNICCENTER, von http://www.toolscenter.org zu beziehen, ist rasch installiert: Wie
bei MIKTEX einfach alle Vorgaben des Installers akzeptieren. Beim ersten Aufruf fragt
TEXNICCENTER, ob es sich für die Verwendung mit MIKTEX konfigurieren soll, was man
bejaht und alle weiteren Vorgaben wiederum akzeptiert.

3.4 Emacs einrichten

EMACS ist wohl der mächtigste aller Editoren und einen Tick komplizierter zu installieren
als TEXNICCENTER, weswegen dies hier durchgegangen werden soll. �

Ein Mängel von Windows muß zunächst vor dem ersten Start behoben werden, nämlich
die Nichtexistenz der Umgebungsvariablen17 HOME. Dazu erstellt man in Start→ Einstellun-
gen→ Systemsteuerung→ System→ Erweitert→Umgebungsvariablen18 einen neuen Eintrag
mit Namen HOME und weist diesem ein beliebiges Verzeichnis zu, in dem man alle individu-
ellen Einstellungen speichern möchte19. Der Name des Verzeichnisses darf kein Leerzeichen
enthalten (siehe Abschnitt 3)!

Für alle Umgebungsvariablen gilt: Möchte man die Umgebungsvariablen nur für den
aktuellen Benutzer anlegen, erstellt man sie in Benutzervariablen. Sollen sie für alle Be-
nutzer gelten, werden sie in Systemvariablen angelegt. Wir benötigen EMACS in der Ent-
wicklerversion, welche bereits spezielle Funktionalität zur Anzeige von Graphik enthält,
die die freigegebene Version noch vermissen läßt. Nette Menschen stellen die Entwickler-
version für Windows fix und fertig als Archiv zur Verfügung. So ziehen wir von http:
//www.gnu.org/software/auctex/ den „Emacs+AUCTeX-W32“. Wir packe die Archivdatei
in das Programmverzeichnis aus (auch Winzip kann das), so daß wir dann ein Verzeichnis
wie z. B. C:\Programme\emacs erhalten.

Um EMACS bequemer aufrufen zu können, legen wir aus dem Verzeichnis C:\C
Programme\emacs\bin eine Verknüpfung von runemacs.exe im Startmenü oder auf dem
Desktop ab.

Damit ist Emacs bereits fertig installiert.

3.4.1 AucTEX/Preview-LATEX + RefTEX

AUCTEX muß separat aktiviert werden. Dazu startet man EMACS und erzeugt in diesem

16Schlosser, Joachim: EPS Writer für Windows. http://schlosser.info/epswriter.
17Umgebungsvariablen erlauben es, programmunabhängig bestimmte Verzeichnisse oder allgemein Zeichen-

ketten festzulegen, die dann von allen Programmen gelesen werden können.
18Geht übrigens schneller mittels des Tastaturkürzels Windowstaste+Unterbrechen.
19Ich empfehle, ein entsprechendes HOME-Verzeichnis auf einer anderen Partition als C: anzulegen und die

Umgebungsvariable entsprechend zu setzen. Hält man Daten und Einstellungen und Programme getrennt,
kommt man im Ernstfall schneller wieder ohne Datenverlust an ein lauffähiges System.
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3 Installation und Konfiguration

die Konfigurationsdatei .emacs in seinem HOME-Verzeichnis (Unix-Kurzname ~) mit CC
-x C-f ~/.emacs RET20. Dort fügt man folgende Zeilen hinzu:

(setq TeX-auto-save t)
(setq TeX-parse-self t)
(setq-default TeX-master nil)

(add-hook ’LaTeX-mode-hook ’turn-on-reftex)
(setq reftex-plug-into-AUCTeX t)

(setq-default TeX-header-end nil)
(add-hook ’TeX-mode-hook ’(lambda () (TeX-fold-mode 1)))
(add-hook ’LaTeX-mode-hook ’LaTeX-install-toolbar)
(require ’tex-mik)

Dann die Datei speichern mit C-x C-s, Emacs beenden mit C-x C-c, und fertig ist die Instal-
lation. Wenn nun beim Öffnen einer .tex Datei in der Menüleiste die Einträge „Preview“
und „LaTeX“ erscheinen, hat die Installation geklappt.

3.4.2 Ispell

ISPELL kann mit Hilfe meiner Distribution21 sehr einfach installiert werden. Das vorge-
gebene Verzeichnis kann getrost übernommen werden. Auch wird das Programm selb-
ständig zum Suchpfad hinzugefügt. Achtung: die Umgebungsvariable HOME muß bereits
existieren.

3.5 Einrichten der Dateitypen

Zur weiteren Vereinfachung erstellen wir einen neuen Dateityp. Zunächst benötigen wir
eine kleine Erweiterung für EMACS, welche es uns erlaubt, weitere Dateien in einem be-
reits laufenden EMACS Fenster zu öffnen. Die Erweiterung heißt GNUSERV und liegt für
Windows fertig benutzbar auf http://wyrdrune.com/gnuserv.html. Wir benötigen die Be-
ta, ganz unten auf der Seite, Datei http://wyrdrune.com/Files/gnuserve_beta.zip.

Aus diesem Archiv kopieren wir folgende Dateien nach C:\Programme\emacs\binC
: aus dem Unterverzeichnis Release alle Programmdateien (.exe), sowie eins darüber
gnuservauto.el. Außerdem muß die Datei gnuserv.el nach C:\Programme\emacs\site-C
lisp.

Nun legen wir einen neuen Dateityp an. Dazu öffnet man eine Kommandozeile und gibt
folgenden Befehl ein:

ftype Emacs.Document=C:\Programme\Emacs\bin\gnuclientw.exe -qsf "%1"

Sodann können wir diesem Dateityp mehrere Dateiendungen zuweisen. Wir tun dies
für .tex und .ltx mit den Befehlen

20Das Kürzel C-x steht für die Tastenkombination Strg-x, andere Buchstaben äquivalent. Übersetzt also: Strg-
x, Strg-f, „ /.emacs“ eintippen, Eingabe drücken. Die Zeichen „ /“ bedeuten, daß die Datei im HOME-
Verzeichnis abgelegt werden soll.

21Schlosser, Joachim: Ispell compiled for Windows. http://schlosser.info/latex.
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3 Installation und Konfiguration

assoc .tex=Emacs.Document
assoc .ltx=Emacs.Document

Ab dann führt ein Doppelklick auf eine .tex-Datei zum Aufruf von EMACS.
TEXNICCENTER kann diese Einstellung übrigens auch selbst vornehmen, man wird au-

tomatisch beim ersten Starten des Programms danach gefragt.
Das assoc-Kommando führe ich zusätzlich auch noch für die Dateinamenserweiterun-

gen .sty, .cls, .lco und .bib aus.
Damit ist EMACS komplett installiert und die Arbeit mit dem leistungsfähigsten Editor

für LATEX kann beginnen.
Dies waren die letzten Schritte, um ein System für das Erzeugen von druckfertigen Do-

kumenten im PDF oder Postscriptformat zu konfigurieren. Wer also kein HTML erzeugen
möchte, der ist hier fertig.

3.6 Neues TeX4ht installieren

TEX4HT ist bei MIKTEX dabei, und wenn man die vollständige Installation wählt, auch be-
reits fertig zum benutzen auf der Platte. Sollte jedoch jemand in der Änderungshistorie von
TEX4HT http://www.cse.ohio-state.edu/~gurari/TeX4ht/bugfixes.html22 Neuerungen
entdecken, die er unbedingt schon einsetzen will, bevor sie auch in MIKTEX erscheinen,
lade er sich von der Homepage das aktualisierte Paket herunter.

Voraussetzung für TEX4HT ist zum einen GHOSTSCRIPT, das bereits im vorigen Ab-
schnitt installiert wurde, sowie IMAGEMAGICK, das wie folgt eingerichtet wird:

Von der IMAGEMAGICK-Website unter Downloads23 das entsprechende Windows-Exe-
cutable herunterladen und installieren. Am einfachsten alles bestätigen, was voreingestellt
ist. Dann ist nämlich das Konvertierungsprogramm bereits in den Suchpfad eingetragen.

Zur Sicherheit sollten zunächst die MIKTEX-Pakete für TEX4HT entfernt werden. Dazu
ruft man den MikTeX-Paketmanager auf (mpm.exe) und deinstalliert die Pakete tex4ht und
miktex-tex4ht-bin. Einfach auswählen und das Minus anklicken.

Jetzt kann man daran gehen, das eigentliche TEX4HT zu installieren. Dazu lädt man von
der TEX4T-Bugfixes-Seite http://www.cse.ohio-state.edu/~gurari/TeX4ht/bugfixes.
html24 das neueste Paket herunter, das einen Namen wie etwa tex4ht-1.0.2005C
_03_30_0115.tar.gz trägt und entpackt es nach C:\. Normalerweise sollte jedes neuere
Packprogramm .tar.gz entpacken können. Nun befindet sich in C:\ ein Verzeichnis mit
einem Namen wie tex4ht-1.0.2005_03_30_0115. Dieses Verzeichnis benennt man um in
tex4ht. �

Sodann verschiebt man alles, was im Verzeichnis C:\tex4ht\texmf\tex liegt, nach c:\C
localtexmf\tex. Eventuell muß man dieses Zielverzeichnis auch erst anlegen.

Um nun die neuen Dateien dem TEX-System bekannt zu machen, öffnet man eine Kom-
mandozeile (Start→ Ausführen→ “cmd”) und ruft

initexmf -u

22Ganz am Ende der Link “Log of modifications”
23ImageMagick Windows Binaries. http://imagemagick.org/script/binary-releases.php#windows.
24Neben der regulären TEX4HT-Distribution gibt es auch ein Paket mit einer für MIKTEX angepaßten Version.

Mit dieser habe ich keine Erfahrung, halte sie auch für überflüssig.
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auf.
Dann müssen die ausführbaren Dateien dem Suchpfad hinzugefügt werden. Wie schon

öfters an anderer Stelle ist dazu ein Eintrag in der Umgebungsvariablen PATH zu tätigen.
Also wiedereinmal in Start → Einstellungen → Systemsteuerung → System → Erweitert →
Umgebungsvariablen in der Variable PATH das Verzeichnis C:\tex4ht\bin\win32; vor den
Eintrag für c:\texmf\miktex\bin einfügen, notfalls auch ganz an den Anfang. �

Als letztes ist die Konfigurationsdatei von TEX4HT anzupassen. Dazu öffnet man die
Datei c:\tex4ht\texmf\tex4ht\base\win32\tex4ht.env, sucht die Zeile

tc:\lstinline\tfm!

und ersetzt sie durch folgende zwei Zeilen:

tc:\texmf\fonts\tfm!
tc:\localtexmf\fonts\tfm!

TEX4HT ist nun installiert und kann benutzt werden. Will man den OPENOFFICE.ORG-
Export von TEX4HT nutzen, muß ein Zip-Packer im System verfügbar sein. Ich verwende
dafür INFO-ZIP25, wobei ich nur die Datei zip.exe in ein Verzeichnis kopiere, welches
ohnehin bereits im Suchpfad enthalten ist. Wird bei der ersten Benutzung von oolatexC
.bat festgestellt, daß die erzeugte OPENOFFICE.ORG-Datei fehlerhaft ist, kann dies in der
Regel behoben werden, indem abermals die Datei c:\tex4ht\texmf\tex4ht\base\win32C
\tex4ht.env editiert wird und die Marken <oo-alt> und </oo-alt> durch <oo> bzw. </C
oo> ersetzt werden und umgekehrt, womit eine alternative Bearbeitung aktiviert wird.

3.7 Installation komplett

Herzlichen Glückwunsch! Auch TEX4HT ist nun installiert und das TEX-System kann alle
wichtigen Ausgaben erzeugen.

Wie sieht es mit einem Export nach Word aus? Es gibt im Prinzip keinen Grund, LATEX
nach Word zu exportieren, trotzdem existieren Programme, die LATEX nach Rich Text For-
mat (.rtf) konvertieren, welches sich dann problemlos in Word öffnen läßt. Als besten
Weg empfinde ich jedoch den Weg über HTML oder OPENOFFICE.ORG. Heißt: LATEX mit-
tels TEX4HT nach HTML oder OPENOFFICE.ORG konvertieren, und dies dann in Word
bzw. OPENOFFICE.ORG öffnen.

4 Benutzung

Die Erzeugung der Ausgaben können in der Regel von den Editoren ausgelöst werden,
dafür gibt es entsprechende Knöpfe und/oder Tastaturkommandos.

Für die Benutzung der EMACS-Zusätze sei auf deren Dokumentationen verwiesen. Mag
der Einstieg auch hart erscheinen, es lohnt sich wirklich.

4.1 Benutzung von TeX4ht

TEX4HT ist ein flexibles Werkzeug, wenn es darum geht, LATEX nach HTML zu konver-
tieren, jedoch verliert man bei den vielen Optionen anfangs leicht den Überblick. Mit ein

25Info-Zip. http://www.info-zip.org.
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wenig Übung läßt sich jedoch auch hier alles erreichen, was man sich vorstellt.
Die TEX4HT-Dokumentation an sich ist nicht besonders üppig. Eine komplette Aufli-

stung der Optionen, ausgegeben in die Logdatei, erhält man jedoch, wenn man einen Auf-
ruf

htlatex.bat myfile.tex "info"

in der Kommandozeile auf einer beliebigen LATEX-Datei absetzt. Unbedingt htlatex.bat �

aufrufen, nicht einfach htlatex, da sonst ein MikTeX-Programm gestartet wird.
Da ich so klares XHTML und so kleine Dateien wie möglich erhalten möchte, verwende

ich den meist den Aufruf

htlatex.bat myfile.tex "xhtml,2,fn-in,NoFonts,fonts,graphics-,sections+,C
next"

für die Umwandlung. Das erzeugt XHTML, eigene Dateien für zwei Gliederungsebenen,
keine speziellen Schriftenanweisungen, aber prinzipielle Formatierungen, nichtskalierte
Graphiken und hilfreiche Hyperlinks. Wer eine originalgetreuere Wiedergabe der Schriften
haben möchte, läßt die Option NoFonts weg, was natürlich zu ein wenig größeren Dateien
führt. Für eine monolithische Datei wird statt der 2 eine 0 angegeben.

4.2 Graphikumwandlung

Alle Graphiken, die man in einem Dokument verwendet, müssen natürlich irgendwo her-
kommen. Generell rate ich stark davon ab, Diagramme oder Graphiken als Bitmap zu er-
stellen, etwa mit Photoshop oder ähnlichen Programmen. Vielmehr rate ich zu vektorori-
entierten Programmen wie z. B. CorelDraw, OpenOffice.org Draw, Visio oder ähnlichen.
Fast alle Anwendungen wie Excel oder PowerPoint oder MATLAB verarbeiten ihre Gra-
phiken ebenfalls vektororientiert, und erzeugen deshalb mit Hilfe des Apple Druckertrei-
bers hervorragende Postscriptdateien. Diese Postscriptdateien wandelt man dann in EPS
um26.

Die generierte Datei mit der Erweiterung .eps lädt man in GSVIEW, um zu sehen, ob
z. B. noch die Bounding Box angepaßt werden muß. Um in GSVIEW die Bounding Box
anzeigen zu lassen, wählt man Menü Options→ Show Bounding Box.

Sollte die Bounding Box nicht stimmen, so kann mit dem Befehl File→ PS to EPS entwe-
der automatisch oder manuell die Bounding Box festlegen lassen und die Ausgabe in eine
neue Datei speichern. Automatisch kann man dabei wählen, wenn die komplette Graphik
verwendet werden soll. Manuell wird man die Bounding Box nur dann festlegen, wenn
unerwünschte Kopf- oder Fußzeilen abgeschnitten werden sollen. �

Unbedingt beachten: Erstellt man Postscript oder DVI, müssen Bilder im (Encapsulated)
Postscript-Format (EPS) vorliegen, wohingegen beim Verwenden von PDFLATEX hingegen
nur Graphiken verarbeitet werden, die in PDF, JPEG oder PNG vorliegen. Zwar kann man
sowohl dem einen, als auch dem anderen LATEX-Prozessor alle Bildtypen beibringen, muß
dazu aber spezielle Optionen verwenden, die dann vielleicht nicht portierbar auf andere
Systeme sind. Soll also beides – DVI und PDF – erzeugt werden, müssen die Bilder mei-
stens auch in zwei Formaten vorliegen.

26siehe dazu auch Schlosser, Joachim: EPS Writer für Windows. http://schlosser.info/epswriter
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5 Wenn etwas nicht funktioniert

Will man mittels PDFLATEX aus seinen Dokumenten das PDF erzeugen, so müssen die
EPS-Dateien also nach PDF umgewandelt werden. Dazu gibt es den Befehl epstopdf, der
etwa so aussieht:

epstopdf file1.eps

Bitmapdateien wie JPEG oder PNG werden von PDFLATEX direkt gelesen. Nur für den
normalen LATEX-Aufruf müssen sie mit bmeps nach EPS umgewandelt werden .

Graphiken, die man mittels METAPOST erzeugt hat, einer Graphiksprache, die standard-
mäßig bei LATEX dabei ist, können ohne Umwandlung eingebunden werden.

5 Wenn etwas nicht funktioniert

Sollte irgendetwas nicht funktionieren, oder sich offensichtlich seltsam verhalten, ist das
kein Beinbruch. Häufig liegt es an vergessenen Umgebungsvariablen. So sollte zunächst
überprüft werden ob alle von dieser Anleitung geforderten Umgebungsvariablen entspre-
chend gesetzt wurden. Fehlt eine, oder ihr Inhalt ist falsch, dann ist es möglich, daß eine
danach durchgeführte Installation – vor allem von PREVIEW-LATEX – fehlschlug. Also noch-
mal. Außerdem eine beliebte Fehlerquelle: Dateien am falschen Ort. Einfach nochmal nach
Anleitung kontrollieren und ggf. korrigieren.

Gegebenenfalls sollte man dann auch einen Blick in die Installationsanweisung des je-
weiligen Pakets werfen, ob dort noch weitere Hinweise zu finden sind. Denn natürlich
auch nicht auszuschließen ist, daß meine Anleitung einen Fehler enthält. Wenn eigentlich
alles stimmen müßte, am besten unter Angabe der Versionsnummer bei mir nachfragen.
Vielleicht habe ich eine Annahme getroffen, die nicht allgemein statthaft ist, oder eine neue
Version eines Pakets arbeitet anders und dieser Text ist veraltet.

6 Ausblick

Bei all den Möglichkeiten, die einem die Vielzahl der Pakete für LATEX bieten, gilt immer:
nicht in den Spielereien verlieren. Einfache Layouts und Strukturen wählen, insbesondere,
wenn das Dokument auch in HTML publiziert werden soll.

Bei weitem nicht alle Feinheiten der Dokumentenumgebung können in diesem Umfang
erörtert werden. Mit Hilfe dieses Artikels jedoch sollte es jedem einigermaßen mit Win-
dows vertrauten Benutzer möglich sein, relativ rasch mit dem Schreiben und Setzen von
Texten beginnen zu können. Ich selbst habe erst 2002 LATEX für mich entdeckt und möchte
es nicht mehr missen. Jeder wird, wenn er sich erst einmal darauf einläßt, von den Vortei-
len begeistert sein, die es bringt, seine Texte in hoher Qualität setzen zu lassen anstatt sich
über die Unzulänglichkeiten eines Wortprozessors zu ärgern.

Wenn dieses Dokument dazu beiträgt, die Scheu vor der Einrichtung und Nutzung eines
solchen Systems ein wenig zu lindern und somit die Hemmschwelle zum Einstieg in LATEX
herabzusetzen vermag, dann hat es seinen Zweck erfüllt.
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